# Table Of Contents

## Articles:

A Simple Model for Teaching Functions of the Kidney Nephron  
Harold L. Wilkinson  

Serial Laboratories to Teach Research Skills  
Donald H. Mansfield  

Writing Your Own Tutorials With Hypercard  
Patricia S. Bowne  

## News & Views:

Letter from the President  
AMCBT Meeting Tentative Agenda  
Codons -- James Waddell  

---

Cover by Mark Rich:  
This ground-level scene shows two native plant species, the common milkweed (Asclepias syriaca) and wild petunia (Ruellia humilis), that under some conditions successfully compete with European species, represented here by Tartarian honeysuckle (Lonicera tatarica) and brome grass (bromus sp.). In the bottom portion a red milkweed beetle (Tetraopes tetraophthalmus) contemplates the ascent.
Midwest Bioscene Editor:
John R. Jungck
Department of Biology
Beloit College
700 College St.
Beloit, Wisconsin 53511

Managing Editor:
Kirsten B. Milligan

Please submit all manuscripts directly to the Editor. We prefer receiving two printed copies and one in computer-readable form. We work with the following word processors on the following computers: MacWrite and Word on the Macintosh, AppleWorks and Applewriter on the Apple IIe/Iic, Word Perfect on IBM PC compatibles, TDF on an HP 3000, and WHIPS Plus on a DEC VAX. Final copy is prepared in Quark Xpress on a Mac II. If you can submit your manuscript only on another system, please check with us beforehand. We hope to be on BITNET soon so that we can receive manuscripts electronically; however, we currently have no capacity to do this other than by connecting through AppleLink where our address is BioQUEST. Please address file to AMBCT. Deadlines for 1990: April 15 and October 27.

Midwest Bioscene Editorial Board:

Chatperson:
Robert H. Buchholz
Biology Department
Monmouth College
Monmouth, IL 61462

Joe Kapler
Biology Department
Loras College
Dubuque, IA 52001

Ray Reed—Secretary
Biology Department
Jefferson Community College
Louisville, KY 40210

Phyllis Kingsbury
Biology Department
Drake University
Des Moines, IA 50311

Russ Tepaske
Biology Department
University of Northern Iowa
Cedar Falls, IA 50613

William Brett
Biology Department
Indiana State University
Terre Haute, IN 47809

Richard Knowles
Biology Department
Saint Mary's College
Winona, MN 55987

Robert L. Wallace
Biology Department
Ripon College
Ripon, WI 54971

Dave Finley
Biology Department
Lincoln University
Jefferson City, MO 65101

Malcom P. Levin
Biology Department
Sangamon State University
Springfield, IL 62708

C. Robert Wikkel
Biology Department
Doane College
Crete, NE 68333

George Garan
Biology Department
Southern Illinois University
Carbondale, IL 62901

Suggestions for Manuscripts:

Announcements
Laboratories that work
Courses that work
Minority Education
Computer Advice

Letters to the Editor
Sources of Funding
Professional School
History of Biology
Review of Software/Hardware

Book Reviews
Sociology of Biology
Biology Policy Issues
Women in Biology
Philosophy of Biology

Midwest Bioscene is published by the Association of Midwest College Biology Teachers.
A SIMPLE MODEL FOR TEACHING
FUNCTIONS OF THE KIDNEY NEPHRON

Dr. Harold L. Wilkinson
Department of Biology, Millikin University
Decatur, IL 62522

HISTORICAL BACKGROUND

Understanding the function of the kidney has been the undertaking of many brilliant minds. Its history dates back into the 1800's, when scientists such as Bernard, Bowman, and Heidenhain pioneered early thought about regulation of the fluid that bathed animal cells.

Claude Bernard (1878) is attributed with recognizing that higher animals have two environments to deal with in life: (1) the milieu exterior and the (2) milieu interior. He observed that the milieu interior never varied, consequently it provided a constant environment for cells by acting as buffer against the ever-changing milieu exterior. ¹

Today, most of us are aware that the milieu interior described by Bernard is the extracellular fluid surrounding cells, with the adjacent environment being the interstitial fluid and a removed environment being the plasma of the blood. W. B. Cannon (1929) explained that "the unchanging nature of the milieu interior was due to physiological control systems excited to action by slight deviations of state. This control system is now known to be the Kidney. It is easily shown that under all conditions the kidneys excrete a urine of such composition as to offset any tendency toward deviation in the composition of the plasma."²

How this was accomplished was an issue of hot debate in the middle 1800's. Establishment of the nephron as being the structural unit of the kidney was generally accepted, but the function of the nephron was disputed. Two lines of reasoning were developed, one by Bowman (1832) and the other by Heidenhain (1874), which were not in agreement.³

Bowman's group claimed that the nephron produced urine by first excreting water and salts through the glomerulus and then adding secreted waste products such as urea and uric acid along the nephron. The eventual urine was concentrated by passive movement of water out of the nephron due to osmotic pressure differences across the wall. Blood pressure was the primary force creating urine and experiments correlating blood pressure changes and amount of urine formed was supportive of their hypothesis. The overall process was considered to be a passive process using natural gradients and forces.¹

Heidenhain, on the other hand, an adherent of the vitalist theories of the day, claimed that the glomerulus secreted water and salts and that these secretions were enriched with various additions of salts, waste products and foreign substances by the tubule. Their theory required discrimination on the part of the glomerulus and tubule cells and was considered to be an active process.¹

It was not until 1917 when Cushney, in
Figure 1

Figure 2

Functions of the Kidney Nephron

Wilkinson
his monograph *The Secretion of Urine*, suggested a "modern theory" of urine formation which precipitated research that led to the understanding that we have today. Cushney proposed that the initial step in urine formation occurred at the glomerulus by filtration. The ultrafiltrate thus formed would have the same composition as plasma and was produced as a result of the hydrostatic pressure of the blood. Substances such as glucose, amino acids, etc., which are present in blood but not in urine, were thus thought to be reabsorbed by the tubule. Finally, it was proposed that large amounts of water would have to be reabsorbed in the tubule in order to account for concentrations of waste products such as urea. Secretion as a tubular process was denied.4

In the middle 1900's, through the exceptional work of Homer Smith and some of his students, our understanding of nephron function was clarified. From Smith's work concepts such as tubular secretion and clearance became known.

**BASIC CONCEPTS**

The purpose of this article is help the student of physiology understand the concepts elucidated by Homer Smith and his followers. Although simple in principle, these concepts are often difficult for the beginning student to understand; therefore, it is helpful if the sense of vision, as well as other senses, can be used.

A first point for students to remember is that the kidney, more specifically the nephron, performs four basic functions: (1) filtration, (2) secretion, (3) reabsorption, and (4) excretion. The simple components of the kidney that perform these functions can be modeled as a filter attached to a tube, as in Figure 1.

- **Filtration** is defined as movement of water and solutes from glomerular capillary blood to lumen of Bowman's Capsule across the podocyte filter.
- **Secretion** is defined as movement of solutes from blood to tubular lumen across the cell layers of nephron tubule and peritubular capillary.
- **Reabsorption** is solute and water movement in reverse of secretion i.e. tubular lumen to capillary lumen.
- **Excretion** is the movement of solute and water along the nephron to its eventual destination in the pelvis and urinary bladder.

It is evident that the first three of these processes involve the movement of water or solutes between two compartments separated by one or more cell layers. This movement can be either passive, using concentration or electrical gradients, or active, using energy supplied by the cells.

**THE MODEL**

The components of the system modeled in Figure 1 (see page 4), although accurate in representing the actual nephron, lack the flexibility of being able to illustrate these movements across membranes and along the nephron within a classroom setting. Figure 2 (see page 4) represents a model that was developed to overcome these shortcomings and demonstrate the four basic processes of the nephron as well as passive movement of water and solutes between compartments. It is most
useful in conjunction with theoretical explanations of the basic principles involved. It is by no means intended to replace experiments that might demonstrate the actual function.

There are three parts to the model: a small square box with a 4 1/2 inch hole cut in the bottom that is covered with hardware cloth; a cylinder of hardware cloth that has been overlapped the entire length and half the circumference to create two different size holes on each half of the cylinder; and a rectangular box that is the same length as the cylinder with holes cut in the top and bottom to allow the cylinder to be inserted into it. The individual parts are illustrated in Figure 3.

The parts can be used separately or together to demonstrate the basic concepts mentioned earlier. They are used in conjunction with an artificial solution made up of beads or other particles to represent the body fluids (see Table 1). Most of the "solution" pieces are able to pass through the grid of the screen and because they come in variable sizes and colors they can be used to represent different molecules of blood and urine. Size differences give a degree of individual permeability to the pieces and can be used to advantage in a demonstration using the model. Previous use of the model has involved the types of particles listed in Table 1. It has been suggested that, instead of using air as the medium to represent water, small glass beads should be used because this would more closely simulate the actual situation. Figure 4 (see page 8) illustrates the relative size and appearance of the different solution particles.

**USING THE MODEL**

**PREPARATION OF A SOLUTION**

The concepts of volume and concentration can be reviewed with your students by using the particles to represent molecules of the solution. Prepare a solution of plasma by taking a 500 ml beaker and adding a measured amount of beads representing water. The water particles contained in a filled 100 ml beaker could be counted by the student and the idea that water has a concentration could be made. At this point have a few other students count out 100 pieces of

<table>
<thead>
<tr>
<th>Type of Item</th>
<th>Source of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extrusions (Red or White)</td>
<td>Lab Aids Biological Supply</td>
</tr>
<tr>
<td>Pop Beads (various colors)</td>
<td>Chromosome Simulation Kit - Carolina Biological Supply</td>
</tr>
<tr>
<td>Faceted Beads (8mm)</td>
<td>Local Craft Shop</td>
</tr>
<tr>
<td>Starflakes (12mm)</td>
<td>Local Craft Shop</td>
</tr>
<tr>
<td>Tri-beads (12mm)</td>
<td>Local Craft Shop</td>
</tr>
<tr>
<td>Bubble Gum Balls</td>
<td>Walgreens Drug Store</td>
</tr>
<tr>
<td>Poker Chips</td>
<td>Local Game Store</td>
</tr>
<tr>
<td>Glass Beads</td>
<td></td>
</tr>
</tbody>
</table>

Table 1: Items used to represent Plasma and Urine Solutes
Figure 3

Glomerulus

Filter Screen

Tubule

Opening for Adding Solutes

One side of the screen has larger openings than the other to give variable permeability

Tubule made from 1/2" hardware cloth

Peritubule

Opening for adding and removing peritubular solutes to one or two compartments

Top view of Peritubule box shows partition that could be added to provide two longitudinal peritubular compartments
Representative Molecules

- Glass Bead: Water
- Extrusions: Small Protein or Carbohydrate
- Pop Beads: Globulin or other Protein
- Connected Pop Bead: Protein Dimer
- Faceted Bead: Glucose or Inulin
- Tri-Bead: Urea
- Starflake: Amino Acids
- Gum Ball: Large Proteins
- Poker Chip: Grid Section

Figure 4
the particles representing solutes of the plasma. Have them place the particles in a graduated cylinder to see how much volume this represents. Have them express the concentration of the particles as 100 pieces per "x" ml. Add the particles to the 500 ml beaker containing "water". After thorough mixing of all the particles, fill a 100 ml beaker with a sample of your solution and then have some students determine the now diluted concentration of the different solutes. Point out that each solute has its own new concentration and that it represents the plasma concentration $P_x$. There are as many plasma concentrations ($P_x$) as there are solutes. This is also a good time to note that the combined concentration of all solutes represents the Osmolar concentration of the solution. Pedagogically, this is a good point to review the difference between Osmolar concentration and Molar concentration.

**DEMONSTRATING FILTRATION AND GFR**

Using only the part of the model representing the glomerulus, place your artificial solution into it in such a way as to avoid early passage of the particles through the screen representing the filtration membrane. Place the empty 500 ml beaker under the screen opening and while holding it securely in place, proceed to shake the arrangement in a random way so that a portion of the solution will pass through the screen without filtering out all of the smaller pieces, thereby leaving only large ones behind. Point out that the forces governing filtration are hydrostatic and osmotic pressures and that gravity, a dominant force here, would have no effect of the in vivo situation. The sample you have collected in the beaker represents the ultrafiltrate.

*Have students measure its volume and the concentration of the different solutes. Does the concentration match what is left in the glomerulus? In vivo it does. If it is not reasonably close you haven’t shaken randomly enough.*

*Are some particles not filtered? Red Blood Cells and large proteins are usually unable to pass the filter.*

*Point out that the volume you have collected divided by the time of shaking represents the glomerular filtration rate. ($GFR = mls$ filtrate/time of filtration)*

*Also point out that each solute has its own filtration rate ($F_x$) which can be determined by dividing the number of pieces in the entire filtered sample by the time of shaking. ($F_x = grams$ solute "x"/time of filtration).*

At this point you could introduce the mathematical relationship that $F_x$ is also equal to ($GFR$)($P_x$). Have the class members calculate this value using values previously measured with this system and compare the theoretical with the actual.

**DEMONSTRATING REABSORPTION AND EXCRETION**

The property of reabsorption is demonstrated using the peritubular portion of the model. The wire representing the tubule should be in place in the peritubular box. While holding the box at a 45 degree angle and with the lower end of the model positioned over a shallow pan, add the
filtered material from the 500 ml beaker. (If the tubular screen has been prepared with two size openings, be sure that one of the two halves is on the lower side of the angled setup). As the artificial ultrafiltrate passes through the tubule its contents will be changed as particles pass out into the peritubular space by "reabsorption". Now have the students examine the solution (artificial urine) in the collecting pan. The volume of particles collected divided by the time of passage represents the urine flow rate \( V \). By counting the number of pieces of each solute and dividing it by the total volume the urine concentration of each solute \( U_x \) can be determined. Individual excretion rates \( E_x \) can be determined by multiplying \( V \cdot U_x \). The reabsorption rate can be determined by opening the small door on the peritubular box and emptying the contents into a beaker. By counting the number of pieces of each individual solute and dividing this by the time of passage you will get the individual reabsorption rates \( R_x \).

**DEMONSTRATING SECRETION**

In order to demonstrate secretion the peritubular box must be prepared by adding a solute (know its concentration) to the opening on the side. Use a sample of the artificial ultrafiltrate prepared earlier and follow the procedure for demonstrating reabsorption. It will be necessary, however, to shake the setup to provide the energy of transport across the tubular wall. Again try to do this is such a way as not to bias the results. After shaking the setup, make quantitative measurements of the urine sample. The concentration of secreted material should increase in the urine over what it was in the artificial ultrafiltrate. Point out that this increase is due to adding solute to the tubular fluid and not due to reabsorbing water. The secretion rate of this substance "X" \( S_x \) can be determined by emptying the peritubular compartment and counting the remaining "molecules" of \( x \) and divide this by the time of shaking.

**DEMONSTRATING CLEARANCE**

Now we are ready to demonstrate the concept of clearance. Clearance \( C_x \) is defined as the volume (ml) of plasma that is cleansed of all of a particular solute per minute. Each substance in the plasma then has a clearance rate. All substances but water have positive clearance rates. Clearance, in order to demonstrate it accurately, must be performed on an intact kidney system but for our purposes the intact nephron model will do. Start by placing a sample of your artificial plasma into the glomerular box. Position the opening over the upper end of the peritubular box and then add a collecting beaker or box to the other end. While noting the elapsed time, proceed to shake the setup thoroughly until you have a sufficient quantity of artificial urine. Note that there are only two fluids that you can work with or measure, plasma and urine. The ultrafiltrate cannot normally be sampled clinically. To determine the clearance you must know the plasma concentration of each solute \( P_x \), the urine flow rate \( V \), and the urine concentration of each solute \( U_x \). After determining these values they can then
be inserted into the formula:

\[ C_x = P_x \frac{V}{U_x} \]

and the clearance may be calculated. Take time at this point to explain the analogy with the actual kidney. Discuss shortcomings and weaknesses of the model in accurately representing the intact kidney.

**SUMMARY**

With careful preparation and forethought this model can be used to explain in a simplified way the workings of the kidney nephron. It can introduce the students to the mathematical relationships between the four functions of the kidney and help them to develop a working knowledge of the application of these relationships in clinical nephrology. Basic chemical processes such as filtration, concentration, diffusion, osmosis, etc. can be effectively demonstrated, allowing the students to actually visualize what happens.

**LITERATURE CITED**


**Illinois Association of Community College Biologists**

**Spring 1990 Meeting**

On Saturday, April 21, 1990, the IACCB will meet in Chicago to spend the morning at the Shedd Aquarium for a "behind the scenes" tour. After lunch at the Field Museum, members will learn how to better use the Field Museum for educational purposes.
SERIAL LABORATORIES TO TEACH RESEARCH SKILLS

by Donald H. Mansfield
Associate Professor of Biology
The College of Idaho
Caldwell, ID 83605

A major challenge lies ahead for science educators. We must do a better job in recruiting students to science and retaining them from the moment they enroll in their first science course. Several task forces, professional societies and conferences have addressed the challenge by articulating goals of science education at all educational levels. Being from a liberal arts college, I find of particular value the "Oberlin College Ohio Report, 1986; Maintaining America's Scientific Productivity: The Necessity of Liberal Arts Colleges" (see also Walsh, 1986). Of several goals suggested in the report, this paper offers an idea pertinent to this one: "to engage students in the research process."

In our enormous discipline, we nearly universally accept the tenet that the lab/field is the place to do science, and so we may ask: How can we engage students in research in our laboratory courses? If our laboratory courses are effective at engaging and preparing students for research, then students should be both eager and able to conduct directed research during their senior years.

So how do we plan our laboratories to engage students in research? Numerous skills, processes and attitudes have been identified in the literature as being part and parcel of the research process. One study (Tamir and Amir, 1987) suggests that such processes reduce to 7 major activities:

- handling quantitative relationships
- explaining and assessing data
- conceptualizing and planning investigations
- summarizing results
- interpreting and concluding
- selecting form of and presenting findings
- designing experiments

Providing students with experiences that develop these skills should be evident in any lab designed to teach the research process.

We might ask ourselves how our existing laboratories are designed and whether they effectively teach these skills. College biology laboratory education typically has three major goals (von Blum, 1975). Students:

- observe and/or experiment with biological materials to gain first-hand knowledge and to develop or reinforce fundamental concepts
- receive training in the use of techniques, equipment, methods and procedures of the discipline and
- develop a functional understanding of the investigative nature of science.

Nearly every lab manual that I have read claims to have similar goals. Yet the
design of most of our laboratories is closed-format or "cookbook" style, in which the student repeats the past successes of research biologists and rarely experiences the excitement of having a genuine question. While the first two goals are usually attained, and most of the above science processes are engendered, few students become engaged in investigation to the extent that they will develop a functional understanding of science.

A response to the shortcomings of cookbook-style laboratories has been an assortment of investigative laboratories that has emerged over the past 10-15 years. These range in form from term-long projects, with which most of us are familiar, to one period inquiry sessions, such as some activities of BSCS Green Version. Recently, open-ended laboratories incorporating elements of the guided inquiry model have been introduced (Leonard, 1988; Leonard et al., 1988). These labs generally achieve the third goal above and, for the most part develop science process skills.

However, there are some problems associated with investigative laboratories (see for example, Rubin and Tamir, 1988). For example:

- Term-long investigations are often too unstructured for the concrete learner.
- Frequently, the questions that are asked by students are rather trivial.
- Students often feel overwhelmed by all of the procedures that have to be synthesized to complete the investigation. Though science process skills are "taught" in investigative laboratories, they may not be learned by students having certain learning styles. In short, the effective communication of the excitement of research may still elude us.

This paper offers a laboratory scenario -- the serial laboratory -- that attempts to overcome some of the problems of both the cookbook and open-ended investigative laboratories. Serial laboratories address all three of the goals of laboratory education while teaching research process skills.

In serial laboratories a single topic is investigated for sequential laboratory periods in the manner that a research project is conducted.

The Serial Laboratory

Typically, in a research project, protocol is developed with a known system before trying it out on an unknown system. Less guidance is given to students as they progress from the first lab period to the final period, which is a small-scale independent investigation. The first laboratory period involves a typical "cookbook" experiment, in which student instructions pose the background, the research question and the experimental design, and specify procedures for conducting the experiment and recording, analyzing and summarizing the results. Students are guided through the design of the second experiment, which relies on the results of the first period. Procedural details are intentionally omitted, thereby leaving students to apply protocol learned from the first lab. Instructions are given to guide the students in their analysis of results, which are presented in a second post-lab session. Results inspire questions for the third lab experiment
which can be planned and performed in small groups. Procedural details are worked out between the group and the instructor in a pre-lab session before the third and final lab period.

A summary of the goals and contexts of each lab period and activities of pre- and post-labs is shown in Table 1. In this scenario, the focus of the first lab is to assist students in conceptualizing the area of biology being studied, to develop laboratory techniques and to develop data analysis skills. Several research skills, such as designing experiments, selecting form of data for presentation, etc. are deliberately not addressed until later sessions. In the second lab, students must plan the investigation, but the scope is narrowly defined so the planning skills develop in a structured context. Most of the activity centers on application of skills and concepts learned in the previous lab to address a slightly different problem. Because the students are required to present these results to the class, they begin to develop skills in selection and presentation of data.

The second post-lab and subsequent pre-lab are critical periods in the development of the serial lab. Following second lab, a class discussion of the student-presented results, interpretations and conclusions will invariably lead to questions about the biological phenomenon being studied. In preparation for the pre-lab period, small

<table>
<thead>
<tr>
<th>Table 1. Goals and contexts of each stage in a typical serial laboratory scenario.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The Serial Laboratory</strong></td>
</tr>
<tr>
<td><strong>Lab I.</strong></td>
</tr>
<tr>
<td><strong>Goal:</strong> Develop skills in conducting and analyzing results of an experiment using specific methods, procedures and protocols characteristic of the discipline.</td>
</tr>
<tr>
<td><strong>Context:</strong> Preplanned, predesigned, packaged &quot;investigation&quot; of several cookbook laboratories</td>
</tr>
<tr>
<td><strong>Lab II.</strong></td>
</tr>
<tr>
<td><strong>Goal:</strong> Guide data analysis, summary and interpretation</td>
</tr>
<tr>
<td><strong>Context:</strong> Students are guided through planning, designing and performing an investigation. Specific procedures are based on outcome of first lab. Learned concepts, developed protocol and/or specific results are applied.</td>
</tr>
<tr>
<td><strong>Lab III.</strong></td>
</tr>
<tr>
<td><strong>Goal:</strong> Conduct an investigation</td>
</tr>
<tr>
<td><strong>Context:</strong> Open-ended or guided inquiry of biological phenomena. Guiding questions direct the development of an hypothesis and the design of the testing experiment. New resources are provided as necessary.</td>
</tr>
</tbody>
</table>

14 Serial Laboratories Mansfield
groups are assigned the task of selecting a question to investigate and designing an experiment. They are provided with guiding questions to help them plan details of the experiment, though most of the design occurs in the class session or in small group sessions with the instructor.

The serial lab model can be applied to laboratories in lower or upper division courses. I have used this approach in several courses -- most successfully in general (cellular and molecular) biology and plant physiology. An approach I use is to find an excellent cookbook type laboratory exercise (we all know of dozens, I suspect) with several opportunities for application in areas in which I wish to develop subsequent concepts in the course. Typically, the lab exercise I select for modification is one that is interesting for the method, but which may leave students with the usual "so what" feeling after finding what they felt they "should have found."

Such exercises are well suited for serial lab development.

The Serial Laboratory In Enzymology

The serial lab example described here is used in a general (cellular and molecular) biology course. The labs are based on modifications of the laboratory on phosphatase by Abramoff and Thomson (1976) and Clark and Switzer (1977). Reference is also made to the Worthington Biochemicals manual (1977) and Torriani (1966). Table 2 summarizes the questions and activities of each lab, pre-lab and post-lab period in the enzymology sequence. Traditionally, all of the activities through post-lab II are scheduled for a single lab period. In the serial lab, these are extended to two lab periods, mainly because several of the questions are eliminated, leaving the students to fill in protocol details based on their learning from the first week's experiences. When the students are asked in preparation for prelab III to plan an investigation, they are instructed to:

* generate research questions
* select one question and formulate an answer in the form of a hypothesis
* make predictions
* identify all variables, and
* design a protocol for an experiment to test the hypothesis.

I have received an assortment of student-generated questions, which may be categorized as follows: One kind of question simply asks whether the enzyme can be found in some tissue. For example, is there phosphatase activity in barley cytosol? Another kind of question is equally shallow, simply asking to do the same thing on another source of phosphatase. For example, what effect does phosphate have on plasma phosphatase? Generally, there are no predictions offered from such hypotheses because the question, at least as asked by most students, is not driven by any hypothetico-deductive reasoning. If the student can provide a rationale for thinking, for instance, that plasma phosphatase is expected or not expected to be inhibited by phosphate, then reasoning to develop a prediction is usually offered and the question should be tested. The most difficult aspect of guiding students at this point is to get them to think about the biology (what would be interesting to test?) rather than the methodology (what can I test?).

The following kinds of student-generated questions exemplify thought about biology and are the type that I desire. One kind asks to investigate a
A SERIAL LABORATORY IN ENZYMOLGY

GOAL: TO INVESTIGATE THE CELLULAR CAPACITY TO HYDROLYZE PHOSPHATE ESTERS WITH PHOSPHATASE

LAB I. QUESTIONS:
- HOW IS AN ENZYME ASSAYED?
- WHAT IS THE EFFECT OF SUBSTRATE CONCENTRATION ON ENZYME ACTIVITY?

PROCEDURES:
- PREPARE A STANDARD CURVE TO MEASURE PRODUCT FORMED
- DETERMINE OPTIMAL ENZYME CONCENTRATION AND REACTION TIME FOR ASSAY (FAMILIARIZE)
- DETERMINE THE EFFECT OF SUBSTRATE CONCENTRATION ON ENZYME ACTIVITY

POSTLAB I. ANALYZE DATA (correct for controls, graph results, calculate kinetic parameters)
- EXPLAIN DATA
- BRIEF, INFORMAL SUMMARY AND REPORT OF RESULTS

LAB II. QUESTIONS:
- HOW DO TEMPERATURE, PH AND PHOSPHATE EFFECT PHOSPHATASE ACTIVITY?

PROCEDURES:
- PERFORM 3 ASSAYS

POSTLAB II. INTERPRET RESULTS
- DRAW INFERENCES AND CONCLUSIONS
- RAISE QUESTIONS

PRELAB III. PLAN INVESTIGATION
- DESIGN EXPERIMENT

LAB III. QUESTION (for example):
- IS A CELL'S ABILITY TO PRODUCE PHOSPHATASE INFLUENCED BY PHOSPHATE CONCENTRATION IN THE GROWTH MEDIA?

PROCEDURE:
- GROW E.COLL, ESTIMATE CELL DENSITY, HARVEST CELLS, AND PERFORM ASSAYS AS REQUIRED BY THE DESIGN

POSTLAB III. ANALYZE AND SUMMARIZE DATA
- SELECT FORM OF PRESENTING DATA
- REPORT RESULTS OF INVESTIGATION

Table 2. Questions and activities of each stage in a serial laboratory on enzymology for a course in general (cellular and molecular) biology.
specific question raised during experimentation. For example, does pH affect substrate affinity? When the question is raised in the context of wondering, the prediction is easy for the student to produce: if pH effects three-dimensional changes in the enzyme structure, then substrate affinity should change with pH. Another kind of question brings other aspects of biology from their past experience. For example, usually at least a few students have had some physiology and may wonder as follows: Does phosphate concentration in a cell's growth environment affect phosphatase? If phosphatase functions to provide phosphate as a nutrient, then production of phosphatase may not occur when phosphate concentration in the cell's environment is high (non-limiting). When students think this way, I jump at the opportunity to channel some groups to test this. Without knowing that they may be repeating the work of Jacob and Monod, they have thought in parallel to those Nobel laureates!

In this example, the identification of variables and design of protocol requires both a class session (the same session in which students are offering their questions) and a meeting with individual groups. This time is taken in lieu of lecture. But when my next lecture is intending to address the operon model, I feel successful rather than "behind." Table 3 illustrates the factors that students should consider in designing one possible experiment. The responses given to student questions about experimental protocol in Table 3 are developed in advance of the unit. Those given in Table 3 are a combination of some that have worked in past student experiments and some that have been taken from the literature. The literature used for such searches included both lab manuals and primary literature in molecular genetics and microbiology. In order for the third lab to be successful, there must be a balance of open-endedness and guidance. The instructor must anticipate the student questions and have a few up her/his sleeve for which details of protocol have been researched and materials have been ordered. Yet the instructor must be prepared to accept student alternative suggestions for protocol as long as they seem reasonable (e.g. there are several ways to lyse cells, even though some may not work as well as others).

The third lab becomes one of the most exciting educational settings I have ever experienced.

However, unlike the previous two labs, there is much uncertainty and the instructor should be prepared for anything. Sounds like research, doesn't it?

Students have respectable questions, experience with related protocols, and motivation to gather, analyze and interpret results.

Evaluation of the Serial Laboratory

The lab series may be used once or several times in a course. For example, I have designed my plant physiology course to consist of two or three serial laboratories, a couple of closed-format labs and a final independent project in which students, alone or in pairs, can put together an entire short project from scratch.

The serial laboratory offers a means to
Table 3. Variables that students should consider in planning the details of a typical experiment. In this experiment, the research question being asked is: Does phosphate concentration in a cell's growth environment affect phosphatase?

<table>
<thead>
<tr>
<th>Factors to be considered</th>
<th>Workable systems to which students can be led</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What cells to use</td>
<td></td>
</tr>
<tr>
<td>2. Media for growth</td>
<td><em>E. coli</em> minimal salts plus glucose; no phosphate in some and a range of phosphate concentrations in other tubes (5 mg/ml KH₂PO₄ saturates the induction response)</td>
</tr>
<tr>
<td>3. How long to grow cells</td>
<td>2 days at 37°C</td>
</tr>
<tr>
<td>4. Buffer to use</td>
<td>0.1 M Tris HCl pH 8.2</td>
</tr>
<tr>
<td>5. How to collect cells</td>
<td>Centrifuge 5 min at 8000g to remove phosphate and resuspend cells in buffer</td>
</tr>
<tr>
<td>6. How to control for variation in cell number in different treatments</td>
<td>Measure A₅₄₀ of blank and either (a) express results per A unit or (b) calibrate turbidity with a hemocytometer and express results per cell</td>
</tr>
<tr>
<td>7. How to make enzyme accessible</td>
<td>Add 1 drop toluene 15 min before assay to lyse cells</td>
</tr>
</tbody>
</table>

Teach the concepts and methodology similar to that offered by the cookbook lab exercises. However, it provides follow-up experiences to those already known to be productive. So, relative to cookbook labs, the open-ended excitement of the inquiry process is maintained. The problem-solving tasks, concept development and familiarization with new procedures or apparatus are emphasized in different sessions so the inquiry process does not become burdensome. Furthermore, structure is retained in the early stages of the sequence thereby providing guidance for learners that need structure before progressing to open-ended experiences. Yet, relative to one-period investigative labs, the question that is pursued in the serial labs can be non-trivial, relying on contemporary methodology. The investigations may even offer answers that might otherwise be "presented" in lecture but instead can be discovered in lab.

Serial laboratories can simulate research in several respects. They provide a progression in which conclusions drawn from one laboratory investigation inspire the inquiry process and subsequent concept development. The serial laboratory scenario presented here also defines the place in the curriculum for methodological training—as a means to the end of inquiry rather than an end in itself.

The serial laboratory has some obvious problems. Perhaps the most significant is that a topic which may have required one laboratory period in a traditional lab course now becomes two to
four weeks of study. Activities in other areas of course content must be cut or reduced in scope. I have found that to compensate for this, I spend less analytic time on other course concepts and more analytic time on concepts related to the topics of the serial laboratories. I have also come to realize that no matter how we define the content of our courses, something important will have to be omitted due to the expanse of the subdisciplines of biology. Having accepted this premise, it is easy to justify spending more time to teach processes as long as the topics on which I focus complement the other departmental offerings and the student's whole education.

Some of the problems of the cookbook laboratories are still evident in the first week of the serial laboratory. Detailed, structured activities are retained in this period. This tends to be difficult for some students. Having to focus on one topic for a long period can be tiresome. Yet usually by the end of the sequence these individuals understand the necessity and importance of detail. Despite the difficulties of the open-ended investigation for some learners, those that persist see the excitement of research that many of us did not experience until we were in graduate school.

LITERATURE CITED


Computer-based instruction can add interest to your classes by presenting material to students in a different format. It lets students learn at their own paces and is available when you're not; in addition, it integrates computer utilization into different courses, helping familiarize students with the machine. Computer programs commercially available for science instruction range from question banks to complex simulations which allow students to design and perform experiments. Using tutorials has the same inconveniences as using any other media. They have to be previewed for content level, accuracy, ease of operation, and compatibility with other course material, and often they don't emphasize what you'd like them to. For many subjects, computer tutorials are not yet available. Two years of searching for tutorials for a nursing pathophysiology course led me to begin writing my own. With a Macintosh computer and Hypercard, a tutorial, once designed, can be made into a computer program in a few days, providing material tailored to the class and the students.

Hypercard allows the construction of branching frame-based tutorials (see Figure 1) - those in which the student sees one computer screen (frame) of information at a time, responds to it, and is routed to another frame depending on the response given.

Making your first Hypercard tutorial is not difficult; at a presentation in Milwaukee, teachers who had never used Hypercard before created three-frame tutorials in fifteen to twenty minutes.

**Designing an Effective Tutorial**

The easiest format to base a frame-based tutorial on is a teaching situation. Imagine yourself tutoring a student about a given concept. You explain it briefly, and then ask a question which requires the student to use the concept. If the answer is correct, you compliment the student and go on to a more complex question, perhaps one which requires some other concepts. If the answer is incorrect, you...
might review the information, explaining why the answer was wrong, or you might give more information or another way to attack the problem. This exchange can be duplicated on the computer. The major difference—and the major drawback—is that in a computerized version you cannot simply ask a question and have the student respond freely, but instead usually limit the student to a multiple-choice question and have the computer respond to each choice. It is important, therefore, to design questions in which the wrong answers indicate a particular kind of mistake on the student’s part, so that you can have the computer respond appropriately.

Several authors have outlined useful principles for designing computer tutorials (Hazan, 1985; Yang, 1987; Poppen and Poppen, 1988; Weller, 1988), putting greatest emphasis on learner control, interaction, and feedback.

- **Learner control**
  Students take learner control for granted, in my experience, and notice quickly if they can’t page forwards and backwards or return to the main menu. These features help make students with any computer tutorial experience feel at home, and reassure those who are unfamiliar with the computer.

- **Interaction**
  However, the single most important feature in students’ reactions to tutorials I have used has been interaction. I very rarely present more than two frames without a question, except in review tutorials. Students enjoy having a dialog with the computer; this seems especially helpful with students who are afraid of the machine. Caught up in answering questions and reading the computer’s immediate responses, they soon overcome their initial discomfort.

- **Feedback**
  My students prefer to have positive feedback for every correct answer. This sort of continuous reinforcement is recommended for students mastering new skills (Poppen and Poppen, 1988), and would be most appropriate in beginning tutorials or reviews. In tutorials where students must apply information to solve problems, continuous reinforcement can be counterproductive—students can “race” through the program, looking only for right answers and not reading the responses to wrong ones. I therefore sometimes bury positive reinforcement in additional information, so that students must read the whole screen to find out whether or not they were correct.

Incorrect answers require instructional feedback. Many commercially available programs give this feedback at the end of the program, but in problem-solving tutorials I prefer immediate feedback which will make the student deal with an incorrect answer before reasoning further from it. Ideally, the computer should address the mistake the student made and explain how to correct it. Instructional feedback often reviews terms and concepts or offers the student a chance to go through a review program. If a student has given several incorrect answers, the feedback may suggest a review with more urgency. However, I would urge caution in using this strategy; since individually-paced tutorials are perhaps most useful for slow learners, it is important that the computer feedback be supportive and not judgmental.
DECIDING ON CONTENT

There are few limitations on the type of material which can be presented in this way, but I find tutorials most useful for leading students through complex problems in which I want them to reason step-by-step rather than by leaping to conclusions. In my tutorials they apply concepts like osmosis, sympathetic system activity, control of blood pressure, and pH to mapping the sequence of events by which a disease leads to various symptoms and complications (see Figure 2). The computer gives choices for each step in the sequence. If the answer given indicates confusion about the concept, a review is offered; if the student chooses an answer which doesn’t directly follow from the previous step, the computer points it out and asks for a different choice. To liven up the tutorials, each is based on a patient’s case and the patient sometimes develops complications during the tutorial which require the student to identify the probable problem and make nursing care decisions. To really make it lively, patients can get steadily sicker until the proper decision is made. Another way to introduce variety is with illustrations. Hypercard has several tools which allow you to draw on the screen, and anatomical illustration banks for the program are commercially available.

The best way I have found to plan a tutorial is to make a branching diagram, writing in the contents of each frame and the pathway the student will follow between them (see Figure 1).

PUTTING IT ON THE COMPUTER

1. Getting started

This article assumes that the reader has used a Macintosh and is familiar with the terms click, double-click, open, and drag, with folders, and with selecting commands from a menu. If you’re not, please refer to the Macintosh System Software User’s Guide (Apple Computer Inc., 1988) section on Basic Macintosh

**Figure 2. A sample card from a tutorial on hypokalemia**

hypokalemia
less than 3.5 mEq/L
↓
less K⁺ will enter the muscle and nerve cells
↓
The cell charge will be more negative (hyperpolarized cells)
↓
the cells will be harder to fire

Which problem is most likely for the client?

- cramps
- hypoesthesia
- hyperesthesia
- tetany
Techniques. You will need a Macintosh with Hypercard installed on the hard drive.

The first thing to master before beginning to program is a little Hypercard terminology. Hypercard is patterned after a stack of index cards, so each tutorial you create will be called a stack. Within the stack, each of the frames you want the student to see is called a card; the cards are connected to one another by buttons, which can be pushed by clicking on them.

When you open Hypercard you will see the Home card, from which you can reach all of Hypercard's functions. You should also see a menu list at the top of the screen, displaying the words File, Edit, Go, Tools, and Objects. If you don't see Tools and Objects, you won't be able to make a tutorial until you've reset the Hypercard User level. To do this, select Last from the Go menu, and click on the Authoring box of the card which appears. This card is only accessible from the Go menu. To get back to the Home card, click on the forward arrow at the bottom of the card.

Take a look at the different menus to orient yourself. The File menu concerns itself with large things - stacks - and allows you to print cards or quit the program. The Edit menu controls cards and the buttons on them. Go deals with moving around in the stack. The Tools menu offers a wide assortment of graphics tools, as well as tools for making fancy printing and for selecting and moving pictures; for information on them, see the Hypercard User's Guide (Apple Computer, Inc., 1988). For a first session you will only use the top row of tools - the hand icon, button tool, and field tool. The Objects menu, finally, lets you create objects like buttons and fields.

2. Creating the cards in your tutorial stack

When you choose New Stack from the File menu a dialog box will appear on the screen and ask you to name the new stack. Type in the name and click on New; you will create a stack of cards with a background similar to that in the Home card (see Figure 3a). Each Hypercard stack has a background, which appears on every card and is accessible by choosing Background from the Edit menu. Hatch marks will appear on the menu bar to indicate you are working with the background. Since whatever you put on the background appears on every card, I usually do not clutter it up with more than a title, text field, and forward and backward buttons (see Figure 3b). If you have created your new stack from the Home card, its background already contains these buttons and one text field; to see the field, select the field tool (the top right-hand tool) from the Tools menu. Click on the field to select it, and you can drag its corners to wherever you want them. A large text field is best, and I find it simplest to have only one.

When you have finished moving the text field to where you want it, click twice on it to see its properties. You will probably want to change the text size and alignment, and this can be done by clicking on the Font command in the properties box (or by using the Text Style command from the Edit menu).

Now that you have the basic pattern of the cards, you can begin entering the information you want on them (see Figure 4a, page 25). To type in information, choose the hand icon from the Tools menu, click on the card, and type. When you have finished the question card, choose New Card from the Edit menu (or
Figure 3. Steps in constructing your tutorial.

a. The card you will see when you have created a New Stack based on the Home card. To see the text field, select the field tool from the Tools menu.

b. After choosing Background from the Edit menu, a title can be typed in (in this example, I used the A tool from the tool menu to make the large letters). The field tool has been used to stretch the text field across the screen. To control the text in the field, use the Text command from the Edit menu or from the field properties box.

press open apple - N). A new card with the same background will appear. Type the feedback to each answer on a separate card.

3. Connecting a question card to feedback cards

For students to see a feedback card when they choose an answer from the question card, each answer needs to have a button which is linked to the appropriate feedback card. The quickest way to do this is to use the arrows at the bottom of the screen to go back to the question card you created and choose New Button from the Objects menu. The button which appears in the middle of the screen will be large (see Figure 4b), but you can change its shape by dragging its corners, just as you changed the shape of the text field. Once you have the button shape you desire, choose Copy Button from the Edit menu (or press open apple - C) to save it in the computer's memory for the rest of the session.

When you have dragged the button to the vicinity of an answer (see Figure 4c), click twice on it and you will see a box containing information about button properties. This allows you to change the appearance or response of the button (to make it a plain outline, erase its name from the Name box), but the important property for now is Link to. Click on this box, and a new dialog box will appear on the screen. Your button is now open for linking to another card. Use the forward arrows (either the buttons on the screen or the arrow keys) to page forward to the card containing the feedback you wish the student to see after choosing this answer. Then click on the This Card button in the dialog box. The box will disappear, returning you to the original card. Choose the hand icon from the Tools menu and click on your new button; you should find yourself at the feedback card. Notice that when you created a button, the computer automatically switched you into the button
Figure 4. Steps in constructing your tutorial

a. I left the background by choosing Background again from the Edit menu, used the Font command to choose Helvetica 14 pt. text aligned at the Left, and typed in the question and answers.

Now that the text for the text field is chosen, any cards made with the New Card command will use the same text style, so this is the time to make the cards that will contain feedback and type in the feedback.

b. To connect the answers with the feedback, I chose New Button from the Objects menu. Using the button tool, this button can...

c. ...and size. I clicked on it twice to see its properties, and used the Link to command to connect it to the feedback card.

tool - whenever you want to move buttons you must choose this tool, and whenever you want to go back to typing you must choose the hand icon again from the Tools menu. For this reason, it will probably be quickest in future to type in all your cards first and then shift to the button tool and add all your buttons.

You have now made the first segment of a tutorial! Simply repeat these steps, entering more questions and linking their answers to feedback cards. It will be easier now, since when you need a button you can choose Paste Button from the Edit menu (or press open apple - V) to apply the button you've already designed. You will, however, still have to link each button individually to the card to which you want it to take the student.

When finished with the session, simply Quit Hypercard and it will automatically save your stack. One problem with the Macintosh is that your stack may be saved inside a folder, so it will not appear on the directory the next time you want to work on it. If this happens to you, choose Find File from the apple menu at the top of the screen, type in the name of your lost stack, and click on the walking man; it will list the location of your stack.
WHAT'S NEXT?

As you become more expert with Hypercard, you will find many options this article has not mentioned: sounds you can attach to buttons, the possibility of linking between stacks, and creative ways to use graphics. If you really get interested in tutorials, though, you'll probably find yourself wanting to do things like keep score of the numbers of right and wrong answers, generate numerical problems, or even incorporate some simulations or animations into the tutorials. These can be done with HyperTalk, a simple language which lets you write commands which the buttons carry out. To explore this language, I recommend the HyperCard Script Language Guide (Apple Computer, Inc., 1988) or The Waite Group's HyperTalk Bible (Waite et al., 1989).

LITERATURE CITED


BioQUEST will present a series of workshops at the meeting of the annual Association of Biology Laboratory Educators from June 4-8, 1990, at Southwest Missouri State University, Springfield, Missouri. If interested, please contact Professor Barbara Newman there.
Announcement and call for papers

International Society for the History, Philosophy & Social Studies of Biology

Northwestern University
Evanston, Illinois, USA
July 11-14, 1991

The ISHPSSB aims to bring together scholars from diverse disciplines, including the life sciences, history, philosophy and social studies of science. The summer meetings are known for innovative, transdisciplinary sessions and for fostering informal, cooperative sessions and discussions.

Areas of interest include ecology, classification, behavior, selection, biotechnology, reproductive interventions, teaching, Darwinism, interdisciplinary method, cognitive and neuro-sciences, gender, ethics, literature & representation, tools & instruments, complex systems theory, immunology, 19th century biology, institutions, fields & disciplines, and genetics. Many sessions have already been suggested and welcome additional participants (the Society's newsletter provides details).

Preference will be given to sessions coordinated around a theme or question rather than to assorted individual contributed papers. Workshops and roundtable discussions or other alternative formats are also welcome. The program committee will endeavor to connect people with related proposals.

Program committee: Peter Taylor, Cornell U.; Larry Holmes, Yale U.; Elihu Gerson, Tremont Inst.; Jim Griesemer, U. Cal. David; Werner Callebaut, Rijksuniversiteit, the Netherlands; Lindley Darden, U. Maryland; Terry Stokes, U. Wollongong, Australia; John Jungck, Beloit College.

Submissions: Suggestions for sessions are welcome at any time. Session abstracts are due by October 30, 1990 and should include title, type of session, description, participants, titles of individual contributions, organizer and chairperson. Paper abstracts are due by January 31, 1991. Submit them to:

Peter Taylor
ISHPSSB Program Co-ordinator
STS Program
632 Clark Hall
Cornell University
Ithaca, NY 14853, USA

Local arrangements: For information concerning registration and accommodation, contact David Hull, Philosophy Dept., Northwestern University, Evanston, Illinois 60208-1315, or consult the Society's newsletter.
CODONS

(A computer program to generate mRNA for manual "translation.")

This program first asks the user how wide the printer carriage is. Next it asks for the number of "strands" of mRNA desired and goes ahead and prints them. It simply prints a line of the letters "A," "C," "G," and "U" representing the bases on an mRNA molecule. There is always an "AUG" codon near the beginning of the strand, but there is no guarantee of a "STOP," although they do appear often enough. The strands are of slightly different lengths, depending on where the "START" codon happened to fall. Other than the one, guaranteed "AUG," the sequence of letters is determined randomly by the computer.

The strands are printed far enough apart so that the paper can be cut into individual "molecules." A suggested use for them is in a discussion or lab setting to give the students some practice at reading a table of codons and a feel for the translation process. The students are instructed to pretend that they are ribosomes and then each is given his or her own mRNA molecule to translate. From there, the students look for the start codon and translate the message, simply writing down the names (or abbreviations) of the amino acids below each of the codons. If time or inclination permits, the instructor may use the blackboard to note the length of all of the "polypeptides" formed and calculate the average. This is a good starting point for a discussion of the value of the redundancy of the genetic code, in that it is unlikely that one of the "STOP" codons will be produced as a result of a random substitution mutation.

Every attempt was made to make the program "crash-proof" so that it responds appropriately, no matter what strange and off the wall answers you give to its questions. It was written and compiled from Turbo Pascal (Version 2.0). The profusely commented source code is included on the disk for those interested in such things.

(A much earlier and more primitive version is also available for the Apple II series of computers. The Apple version is written in Applesoft BASIC and should work on the Apple II, II+, IIc, Ile and IIGS computer. It requires a wide carriage (132 column) printer and was designed with an Epson in mind. However, it would be a simple matter to change the length of the lines printed and printer codes sent.)

This program is in the public domain. To obtain a copy, please send a blank 5.25" diskette to the author:

James Waddell
515 N. State Street
Waseca, MN 56093

(Please specify Apple or MS-DOS (IBM) format.)
Dear Fellow Biology Teachers,

Many happy returns on the new year and hopes that all your classes are going well. As I am sure it has been for all of you, this seems to be an extremely busy year. As Americans we watch the changes in eastern Europe and as biologists we are seeing equally dramatic changes within our discipline; from mRNA that may mutate in transit, to synapses that store neurotransmitters as part of learning. It is an exciting and historical time.

The Association of Midwest College Biology Teachers is also undergoing some dramatic changes. The Steering Committee met in December and under the wonderful direction of Leland Hansen developed an exciting program for our meeting at Terre Haute, October 11-13, 1991. Indiana State has opened a new Biotechnology Center, and the program (see description in this issue) focuses on the incorporation of biotechnology in schools such as ours.

Additionally, we are writing an NSF grant using AMBCT as a consortium. The Undergraduate Faculty Enhancement Program seems a natural for us since it is intended for the "development and implementation of ways to assist large numbers of faculty to learn new ideas and techniques in their fields, and to use the knowledge and experience to improve their undergraduate teaching abilities. ... Projects must be regional or national in scope, and may include seminars, short courses, workshops, and conferences, or a series of such activities, but are not limited to these." The grant must be submitted by April 16, 1990, and I hope to be able to report on it in Terre Haute. Active members of AMBCT will have high priority in opportunities to participate in any programs we would offer should the grant be funded.

I want to remind all of you also of Russ Wagner's motion at our meeting at Beloit. The motion stated that each of us would make every effort to be sure our students get experience in the field each semester. This motion got unanimous endorsement at both the Beloit and Quincy meetings, so may I remind you to try and incorporate its spirit into your curriculum.

Lastly, two thoughts about our meetings. When you order materials from a company that has displayed its products at our meetings, please mention that you saw its display at an AMBCT meeting. This sort of acclamation will encourage vendors to continue their support of our organization. Finally, above all, bring someone with you to Terre Haute. Bring someone who hasn't come to AMBCT in a while, or, even better, someone new. Call a school near you that doesn't send people often or ever, tell them about the meeting, and offer to be their host.

I'm looking forward to seeing you all in Terre Haute in 1990 and in Kansas City in 1991.

Dick Wilson, President 89-90
Rockhurst College
Kansas City, Missouri 64110
BIOTECHNOLOGY IN EDUCATION
AMCBT Fall Meeting
Indiana State University
October 11-13, 1990
Tentative Agenda

Thursday, October 11:

6:00-8:00 PM  REGISTRATION  2nd Floor Science Building

8:00-9:30 PM  OPENING SESSION  SB296

Welcome for AMCBT—President Richard Wilson
Welcome from ISU Dean of Arts and Sciences—Dr. Judy Hample
Program Update and Local Changes—L. Hansen & T. Mullkey

Opening Address
The Galapagos Archipelago - Multimedia Presentation
Jerry Hinkle, College of Lake City, Grayslake, IL

9:30-? PM  INFORMAL SOCIAL HOUR AND CASH BAR  SB201

Friday, October 12:

7:00 AM  REGISTRATION  2nd Floor Science Building

7:00-8:30 AM  BREAKFAST (price included in registration)  SB296

Interest Groups by Discipline

8:30-9:15 AM  CONCURRENT SESSION I

1a.  Biomechanics in a Comparative Anatomy Lab
     Marshall Anderson, Rockhurst College  SB 208

1b.  Science Lectures That Work
     Cathy Hunt, Henderson Community College  SB 293

1c.  AIDS Update
     Sue Speece, Anderson University  SB 296

1d.  Writing Interactive Software Biology Software
     Bill Boraker and Dave Beach, ISU  SB 225

1e.  How Plants Respond to Environmental Stimuli
     Randy Moore, Wright State University  SB 224
9:15-9:30 AM  COFFEE AND DONUTS
Exhibition Area SB 286/287

9:30-10:15 AM  CONCURRENT SESSION II

Iia.  Use of Case Studies in Undergraduate Ecology  SB 224
    Phyllis Kingsbury, Drake University

Iib.  Inquiry and Hands on Demonstrations in  SB 274
    Introductory Biology, Jerry Foote, University of
    Wisconsin

Ilc.  Biotechnology Degree Curriculum at Two-Year  SB 293
    Schools, (Woman from Madison MATC)

Ilc.  Neurophysiology of Gravitational Responses  SB 225
    Steven Cochran, ISU

Ile.  Writing Tutorials in Hypercard  SB 203
    Pat Bowne, Alverno College

10:15-11:15 AM  EXHIBITORS SESSION—Coffee & Roll  Exhibition Area SB 286/287

    POSSIBLE FIRMS:
    Wm. C. Brown
    Harper & Row
    Nebraska Scientific
    Wards
    Bioquest, Inc.
    Modern Biology, Inc.
    Heitschfield Optical
    Boeringer Mannheim
    Pitman-Moore
    ?? Lilly
    Pfizer
    IBM
    Apple

10:15 AM-6:00 PM  "FILM/VIDEO FESTIVAL"  SB 207
    Organized by Wallace Weber,
    Southwest Missouri State University

11:15 AM-12:15 PM  KEYNOTE ADDRESS  SB 296

12:15-1:30 PM  OPEN LUNCH (see handout for area restaurants)
1:00-5:00 PM  **FIELD TRIPS**  
FT2. *Turkey Run State Park—Nature’s Walk*, Marion Jackson, ISU  
FT3. *Terre Haute Landmarks: Historical Museum, Swopes Art Gallery, Debb’s Home*  
FT4. *Pioneer Village and Covered Bridges*  

1:30-5:00 PM  **WORKSHOP SESSION I**  
Wla. *Electrophoresis*  
   John Anderson, Modern Biology, Inc., Dayton, OH  
SB 360  
Wlb. *Fun in the Plant Physiology Laboratory*  
   Tim Mulkey, ISU  
SB 274  
Wlc. *Media Preparation*  
   ???? Friar  
SB 208  
Wld. *Making Interactive Computer Media*  
   Bill Foraker and Dave Beech, ISU  
SB 203  

6:00 PM  **CASH BAR AND SOCIAL HOUR**  
Heritage Ballroom  

7:00 PM  **BANQUET** (Price included in Registration)  
Heritage Ballroom  

8:00 PM  **EVENING SESSION**  
*The Genetic Code as a Code: The Past 30 Years*  
   John R. Jungck, Beloit College  
Heritage Ballroom  

---  

**Saturday, October 13:**  

7:00-9:00 AM  **CONTINENTAL BREAKFAST**  
   (Beverages, Rolls, Fruit)  
   SB 201  
   **BALLOTING**  

9:00-10:45 AM  **WORKSHOP SESSION II**  
Wla. *BioQUEST Biotechnology Workshop*  
   Al Place, Center for Marine Biotechnology, University of Maryland, Baltimore (with the help of Robin Greenler, Patti Soderberg, and John Jungck)  
SB 207  
Wlb. *Development of Monoclonal Antibody-Based Sensitive Immunoassay*  
   Swapan Ghosh, ISU  
SB 201a  
Wlc. *Microphotography*  
   Ann Larson, Sangamon State University  
SB 274
9:00-9:45 AM  CONCURRENT SESSION III

<table>
<thead>
<tr>
<th>IIIa.</th>
<th>Energy Cycles on North American Desert</th>
<th>SB 224</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Gilbert Adrian, Hastings College</td>
<td></td>
</tr>
<tr>
<td>IIIb.</td>
<td>Process to Achieve Biology Major Outcome</td>
<td>SB 225</td>
</tr>
<tr>
<td></td>
<td>Leona Truchan, Alverno College</td>
<td></td>
</tr>
<tr>
<td>IIIc.</td>
<td>DNA Literacy Project at the Cold Spring Harbor Laboratory</td>
<td>SB 292</td>
</tr>
<tr>
<td></td>
<td>John Kruper, University of Chicago</td>
<td></td>
</tr>
<tr>
<td>IIIId.</td>
<td>Genetics in Agriculture</td>
<td>SB 293</td>
</tr>
<tr>
<td></td>
<td>Malcolm Levin, Sangamon State University</td>
<td></td>
</tr>
<tr>
<td>IIIe.</td>
<td>Biotechnology—an Industrial Perspective</td>
<td>SB 296</td>
</tr>
<tr>
<td></td>
<td>Panel from Industry</td>
<td></td>
</tr>
</tbody>
</table>

9:45-10:00 AM  COFFEE AND DONUTS  
Exhibition Area SB 286/287

10:00-10:45 AM  CONCURRENT SESSION IV

<table>
<thead>
<tr>
<th>IVA.</th>
<th>The Wildlife Corridor Concept</th>
<th>SB 224</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Russell Wagner, Lake Mills, WI</td>
<td></td>
</tr>
<tr>
<td>IVb.</td>
<td>Panel Discussion of Biology Curriculum</td>
<td>SB 296</td>
</tr>
<tr>
<td></td>
<td>Robert Muckel (Discussion Leader), Doane College</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Marvin William, Kearney State College</td>
<td></td>
</tr>
<tr>
<td>IVc.</td>
<td>Biological Issues</td>
<td>SB 225</td>
</tr>
<tr>
<td></td>
<td>Robin Greener, Beloit College</td>
<td></td>
</tr>
<tr>
<td>IVd.</td>
<td>Self-Paced Computerized Literature Searches</td>
<td>SB 203</td>
</tr>
<tr>
<td></td>
<td>Jerry Woolpy, Earlham College</td>
<td></td>
</tr>
</tbody>
</table>

11:00-12:30 PM  BRUNCH (Price Included in Registration Fee)

BUSINESS MEETING

Reports:
- Presidential Address—Dick Wilson
- Midwest Bioscene—John Jungck
- Election Results—Dave Finley
- Life Membership—Don Hoffman
- Summary—Biology Curriculum Discussion—Robert Muckel
- Closing Remarks—Dick Wilson

Steering Committee meeting following brunch.
Application for Membership

ASSOCIATION OF MIDWESTERN COLLEGE BIOLOGY TEACHERS

NAME____________________________________ DATE__________

TITLE____________________________________

DEPARTMENT____________________________________

INSTITUTION____________________________________

CITY_________________________________________STATE______

ZIP CODE_____________________

ADDRESS PREFERRED FOR MAILING____________________

CITY_________________________________________STATE______

ZIP CODE_____________________

PHONE NUMBER________________________

MAJOR INTERESTS:

( ) 1. Biology
( ) 2. Botany
( ) 3. Zoology
( ) 4. Pre-professional
( ) 5. Teacher Education
( ) 6. Other ____________________________

RESOURCE AREAS:

________________________________________

________________________________________

________________________________________

RESEARCH AREAS:

________________________________________

________________________________________

________________________________________

Have you been a member before? ________ If so, when?
Please mail application to:

Edward S. Kos
Executive Secretary, AMCBT

AMCBT Central Office
Department of Biology
Rockhurst College
Kansas City, MO 64110

Current Dues are $15.00